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Getting Started 

Introduction 

STISETSWeb is a browser-based Special Education data tracking system that 
provides the Special Education professional with a comprehensive system for 
achieving and maintaining compliance with the Special Education process for 
students. Many state-specific forms are contained in this software. Since this 
software is fully integrated with the information from the local school STIOffice 
program, Special Education personnel may view Student and Guardian 
Demographics, Entries/Withdrawals, Attendance, Discipline, Schedules, and Grades.  

The basics of getting started with STISETSWeb should follow this order: 

• Employees 

• Users (Assign User Names, Passwords, and Security Groups) 

• Create Folders (Assign Case Managers to Students) 

• Change Case Manager (Only if a mistake was made in assigning Case 
Managers) 

• Caseload Assignment (Assigning OT, PT, Speech Therapist, etc., 
access to student records) 

STISETSWeb features pre-loaded reports that will track due dates for IEPs, as well 
as Re-Evaluation reports to determine continued eligibility. Additionally, an 
STISETS Query tool is included. The Query tool allows the user to build custom 
reports filtered by Student, Folder and Form information. Reporting includes both 
school- and district-wide listings.  

The security model is robust enough to secure access not only to different schools 
and their respective menu options, but access can be locked down to the form level. 
Because this program houses a district-wide database, teachers, service providers, 
etc. may be given access to students in multiple schools. Therefore, when an 
employee logs in to the program his/her entire caseload displays, regardless of the 
employee’s relationship to the student. 
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Since this document is intended to assist board office personnel as well as local 
school personnel in implementation of STISETSWeb, certain sections may pertain to 
specific employee duty assignments. The screen below is displayed when an 
employee with administrative rights logs in to the program. 

 

 

Opening Screen 

The opening screen displays menu options based on an employee’s level of access to 
the program.  

An employee’s Username and Password may be secured from your System 
Administrator. The screen on the previous page is displayed for staff members with 
Administrative rights.  

The opening screen below is a sample display for employees with Teacher rights: 
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• Login Info: Selecting this menu option allows the user’s password to 
be changed. 

 

Utilities Desktop 

Clicking the plus sign by the Utilities Desktop from the menu tree on the left displays 
all the sub-menus contained in the Utilities Desktop. Since all management options 
are housed in the Utilities Desktop, only persons with Administrative or Manager 
rights have access to the Utilities Desktop.  

Employees 

To access this menu option, expand the Utilities Desktop.  

• Click this menu option from the menu tree at left to add staff members 
to the employee file. The Search button allows locating previously 
entered employees. There are two ways to enter employees. The 
following steps demonstrate how to enter employees and set up 
security. 

 

 
 

o Clicking Insert allows entry of employees who are not included in 
the local school STIOffice program. For example, the user may 
wish to add psychometrists. Enter the appropriate information and 
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click OK. Note: This option allows entry of the employee’s 
demographic information, Username, Password and Security 
Group. 

o Clicking Import allows the user to import staff information from 
the teacher file in the local school STIOffice program. This option 
is provides a quick way to draw in staff demographic information. 
After clicking Import, the user may search by School, Number, 
Last Name or First Name. Enter the first few letters of the staff 
member’s last name; then click Search. Highlight the desired 
employee’s name and click OK. After editing information on the 
screen, click OK. Note: This option does NOT allow entry of a 
Username, Password or Security. This information must be entered 
from the Users menu. 

Code Desktop 

The Code Desktop houses all codes used in the software. To access this menu option, 
click the plus sign next to Code Desktop.  

• District/State Codes: Currently these codes are the same. Codes 
should be added to State Codes first, and then to District Codes. This 
allows the user to link District Codes to State Codes. The only editable 
codes in this menu are Areas, Staff Student Relationship and Staff Type. 

 

 
 

• Locations: This editable code file is used in conjunction with Student 
Services to specify where the service will be provided. All codes in the 
Code Desktop are created/edited in the same manner. Locations are 
used in the IEP W-2 Supplementary Aids and Services, Personnel 
Supports in Regular Education form and the IEP W-5 SCD Related 
Services and Special Factors form. 

o To add a new code click Insert. After entering a Name, 
Description and Expiration Date, click OK to save. 

o To change an existing code, highlight the desired code and click 
Change. After making changes, click OK to save the changes. 

o To delete an existing code, highlight the code and click Delete. 
Note: Any code that has already been assigned to students cannot 
be deleted.  

• Service Types: Administrators may select this option to view the 
various service types available in STISETSWeb. Service Types are 
used in the IEP W-2 form. 
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• Service Frequency Types: Administrators may select this option to 
view the various service frequency types available in STISETSWeb. 
These codes are used in the IEP W-2 form. 

• Service Type Cross Ref: Administrators may select this option to 
cross reference Service Categories with Service Types. 

• Goal Bank Set Up: Administrators may select this option to set up 
Goal Bank information. This information is used in the IEP W-3a and 
3b forms. 

 

 
 

o To add a new Goal Bank Type code, click Insert on the left of the 
screen. After entering a Code and Description, click OK to save. 

o To change an existing code, highlight the desired code and click 
Change. After making changes, click OK to save the modified 
information. 

o To delete an existing code, highlight the code and click Delete. 
Note: The user cannot delete codes that have already been assigned 
to students. 

o To add Goal Type Information codes, highlight the Goal Bank 
Type in the left column and then click Insert from the right 
column. After entering Grade Level, Description and Strand, click 
OK to save. 

o Goal Type Information codes may be changed by clicking the 
Change button. 

o Goal Type Information codes may be deleted by clicking the 
Delete button. 

o Click the Benchmarks button to add Benchmark information to 
the selected Goal Type. The Insert, Change and Delete buttons 
operate the same on this screen as on previous screens. 
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Security Desktop 

All user security rights are based on user groups, NOT individuals. 

• Groups: To access this menu option from the menu tree click the plus 
sign beside Security Desktop; then click Groups. This menu option 
has a two-fold purpose. 

 

 
 

 
 

o To create a new group, click Insert. After entering a name and 
description, click OK. For example, a group called Counselors 
may be created and then given access only to the referral form; or a 
group called Psychometrists could be given access only to the 
eligibility form. Users may be added to this group by highlighting 
the group name in the left box and clicking Members. At the next 
screen highlight any desired name(s), click Add and then click 
OK. Multiple names may be selected by holding down the Ctrl key 
while clicking on each name. 

o Another purpose of the Groups menu is to add users to existing 
groups. To do this, highlight the name of the group in the left box; 
then click Members. Users may be added or removed by 
highlighting the desired name and clicking the appropriate option, 
either Add or Remove. Then click OK to save the changes. 

• Four security groups come pre-installed with the software. It is 
recommended that these groups not be changed. Additional groups may 
be created to accommodate other security needs. 

o Administrators: Have full access to the software in all schools in 
the district. 
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o General Ed Teacher: Use of this group is optional. To activate 
this group, select Utilities Desktop | System Files. Checking 
Create Gen Ed Caseload automatically creates caseload 
assignments for Gen Ed teachers right after the Scheduled Student 
Update runs. This means that any General Ed teacher who teachers 
a Special Ed student will have view-only rights to the student’s 
Special Ed record. 

o Managers – Have full access to all menu items for their 
individual school. The only menu option this group does not have 
access to is the Edit Permissions menu. In other words, Managers 
have full control over student records in their school, but only their 
school (by default). 

o Teachers – Have full access only to students on their caseload 
(by default). 

• Users: To access this menu option from the menu tree, click the plus 
sign to the left of Security Desktop; then click Users. Previously 
created users may be displayed on the screen. This option allows users 
to be created from the Employee File. If security groups have been 
assigned, the group(s) will display in the right box as the user name is 
highlighted in the left box. To display all current users, click in the Last 
Name field, press the space bar once and then press the Enter key. (This 
three-step process will display any data type, such as students, staff 
members, codes, etc.).  

 

 
 

o Insert: Selecting this option allows creation of a new user. After 
clicking Insert, click the blue plus sign to locate a staff member 
from the Employee file. After highlighting the desired employee’s 
name, click OK. Then enter the User Name, Password, and 
Confirm Password. Click OK, check the appropriate Group(s) in 
the box at right and then click Save. 

o Change: Selecting this option allows a password to be changed. 

o Delete: Selecting this option allows deletion of a user. 

• Effective Permissions: To access this menu option from the menu 
tree, click the plus sign next to Security Desktop. The purpose of this 
menu option is to view permissions of a specific user. No changes are 
allowed on this screen. 

o Object Types: Click the down arrow to select an Object Type 
(School, Form Type or Menu Item). 

o Groups: Click the down arrow to select the desired Group.  
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o Load: Click Load after the desired Group is selected to display 
that group’s Effective Permissions.  

• Edit Permissions: To access this menu option, from the menu tree 
click the plus sign next to Security Desktop. Only employees with 
Administrative rights may access this menu option. This option allows 
editing of rights/permissions for previously created Groups. 

 

 
• Object Types: The three Object Types refer to different types of 

access options. 

o School: Displays all schools in your district, with the option to 
add or remove school(s) access for the selected Group. 

 

 
 

o Form Type: Displays all forms with the option to add or remove 
access to any or all forms. Selecting the checkboxes at the top of 
each column controls the access options vertically. For example, 
clicking in the Full Control checkbox at the top of the first column 
grants full control over ALL forms. You may remove full access to 
a specific form by removing any of the individual checkboxes in 
the Full Control column. For example, if a group needs access 
only to the Referral Form, place a checkmark by that form in the 
Full Control column.  

 

 
 

o Menu Item: Displays all the menu items that are listed in the 
menu tree on the left side of the screen, with the option to add or 
remove access to any menu option for the selected group. 
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Process Desktop 

• To access this menu option, click the plus sign next to the Utilities 
Desktop; then select Process Desktop. This menu provides a view of all 
processes contained in the software. No changes are allowed. As a 
particular process is highlighted in the left box, the right box displays 
all the forms contained in that process. 

 

 

Create Student Folder 

• To access this menu option, click the plus sign next to the Utilities 
Desktop; then select Create Student Folder. A folder should be 
created to track all students who enter any phase of the Special 
Education process. The student folder houses dates to be monitored for 
compliance. These fields will auto-populate from forms that are 
completed in the program. Perform the following steps to create a 
student folder: 

o After selecting Create Student Folder from the menu tree on the 
left, the screen below will be displayed. The person logged into the 
program is by default automatically listed as the Case Manager. To 
change this default to the appropriate Case Manager click in the 
Assign Case Manager field to display the blue plus sign. Click on 
the plus sign to look up the desired staff member. Enter the last 
name of the staff member and click Search. Highlight the staff 
member’s name and click OK. 
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o Enter the last name of the student in the Last Name field. Then 
click Search.  

 

 
 

o After highlighting the name of the desired student, click Import. 
o The student folder will be displayed. Now when the case manager 

of this student logs into the program, he/she will have full access to 
this student’s record. 

Caseload Assignment 

• To access this menu option, click the plus sign by Utilities Desktop and 
then select Caseload Assignment. The purpose of the Caseload 
Assignment section is to create the relationship(s) different staff 
members have to a particular student. The student listed at the top of 
the screen is the student you will be working with. A staff member may 
be associated with a student in multiple ways. For example, a Special 
Education teacher may also provide a related service for a child. All 
assignments are accomplished here except assignment of a Case 
Manager. This assignment is done in the folder. 

 

 
 

o Click Insert to add a staff member to the selected student’s record.  
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o Click the ellipsis button to locate the desired staff member. 

 

 
 

o Enter the last name of the staff member and select Search. 
Highlight the name of the desired staff member and click OK. 

 
 

 
 

o Change: Selecting this option allows the user to change a staff 
member’s relationship to the selected student. 

o Delete: Selecting this option allows the user to delete a staff 
member from the selected student’s Caseload Assignment. 

System Files 

The System Files menu houses several options that enhance the operation of the 
software. To access this menu click the plus sign to the left of Utilities Desktop; then 
select System Files.  

 

2011 STISETSWeb MS         STI_0527111618 Getting Started  •  11 



 

 

Daily Student Update  
• Schedule Student Update: Checking this option allows 

STISETSWeb student demographic data to be updated on a regular 
basis from the STIDistrict database.  

• Scheduled Time: The user should enter the time as HH:MM [a.m. or 
p.m.]. For example: If 2:30 A.M. is entered, this would indicate that 
every morning at 2:30 a.m.., the system will refresh the Special 
Education student information with the latest changes that occur in 
STIOffice (in correspondence with STIDistrict). The time entered here 
should always be AFTER the nightly STIOffice upload. 

• InformationNOW WebServices URL 

• Synchronize Now: Click this button to manually update the 
InformationNOW demographic data in STISETS.  

Miscellaneous Setting 
• Show Student SSN: This allows for students’ Social Security 

Numbers to be hidden (unchecked) or displayed (checked) within the 
STISETS. 

• Inactivity Timeout: Inactivity Logout time may be set here, for up to 
15 minutes. If no activity takes place in the software after the specified 
number of minutes, the software automatically logs the user out. 

• Child Count Date: Enter the appropriate Child Count date in the 
Child Count Date field. Select the Save Tab feature to save the date in 
the program. 

• Take Snap Shot: Selecting this icon creates a Snapshot of the Child 
Count Data.  

• Delete Snap Shot: Click to delete a snap shot. The user will then be 
able to select the Child Count Snapshot to be deleted.  
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Security Policy Settings 
• If desired, an administrator may set restrictions on passwords. 

o Password Expiration Days: This allows for a password to 
expire in a given number of days. For increased system security, 
users may wish to set the system to require password modification 
every 30 to 90 days. 

o Remembered Passwords: This is a setting that allows several 
previously used passwords to be remembered. Users cannot use the 
same password once their password expires. 

o Lockout Minutes: This indicates the number of minutes for 
which a user may attempt to sign on. If a user tries unsuccessfully 
to log in for this amount of time, the system will lock that user’s 
account. The user will then need to go to the administrator to have 
his/her account unlocked.  

o Lockout Threshold: This is the number of times a user may 
attempt to log in with an incorrect password. If a user tries 
unsuccessfully to log in for this number of times, the system will 
lock the user’s account. The user will then need to go to the 
administrator to have his/her account unlocked. 

Delete a Student 
Occasionally it becomes necessary to delete a student. For example, a Special 
Education Folder may have been created by mistake for a student. Deleting a student 
from the STISETSWeb database does not delete the student from the STIDistrict 
database; the only record deleted is the student’s Special Education Folder record.  

Note: You may not delete any student who has completed Special Education forms. 
To access this menu, click the plus sign next to Utilities Desktop; then select Delete 
a Student.  

 
 

• Students may be searched by School, Status, Student Number, Last 
Name, or First Name. 

• After the desired criteria have been entered, click Search. 

• Highlight the name of the student to be deleted and click the Delete 
button on the lower right. 

• After deletion, the program takes you back to the User Desktop. 

• Remember, you have deleted the Folder record only, not the entire 
student record.  
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Mass Assign 
This utility is used to change relationships from one staff member to another. 
Typically it is used at the start of school or end of year when students are moving 
from schools or grades. This process is not looking at Active or Inactive Special Ed 
students; it looks at all Special Ed students. Two steps are used to complete this 
process. The user must first decide which students are to be moved from their current 
teachers. Secondly, the user should decide which teacher will receive these students. 
To mass-move a caseload or relationship, the following steps are necessary: 

 

 
 

• In Find Students, you may search: School, Grade, LRE and/or 
Exceptionality for the students to be moved. 

• An advanced search option is available on the right side of the screen 
called Having. This is an ideal tool for instances when a teacher’s entire 
caseload is to be moved to another teacher. In the Having search, you 
may search for the staff member currently servicing the student and 
what relationship that staff member has to the student. 

• Once you have fulfilled the search criteria, click the Search button. 

• Notice there is one more search option called Assign To. Use this 
feature to define the staff member to whom the selected students are to 
be assigned. The relationship must be defined as well. DO NOT click 
Assign at this point. 

• Select the student(s) from the search box at the bottom of the screen. 
When the box(es) beside the appropriate student(s) have been checked, 
click Assign. 

• Continue this process until all students have been moved to the 
appropriate staff member. 

Archive Students 
This feature is provided to allow users to file away students who are no longer 
receiving services in a district. Since school districts are required to retain student 
files for several years after the students leave, the archive feature eliminates the need 
to perform daily routines on these student records. The Archival process is typically 
an End of Year procedure. The basic action performed during this process is the 
selection of students followed by the mass-exiting of the selected students.  
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Note: To select multiple students, hold down the Shift key on the keyboard and click 
each one. Also note that Archiving automatically changes the Exit Reason. 
Archiving does NOT change the status of the student folder. 

• First search the students as done previously. 

• Check the non-STIOffice checkbox to select students who are not in 
STIOffice Program.  

• Click Search to continue. 

• Continue to the Archive Students box. Select the Exit Reason. The Exit 
Date displays the current date. 

• Check the box next to each applicable student’s name. 

• After all students have been selected, click OK. 
 

 

Un-Archive Students 
This utility is used to bring students back from Archived status. It is recommended 
that this procedure only be used as the Special Education director has outlined within 
your district.  

• First locate the students to Un-Archive. 

o Select the appropriate school and grade.  

o Enter several letters of the student’s last name and/or first name to 
search.  

• Click in the checkbox to un-archive a student or click in the checkbox 
to the right of Un-Archive to select all students. To select multiple 
checkboxes, hold down the Shift key on the keyboard as you check 
each box. 

• After all boxes have been selected, click the Un-Archive button to the 
right of the search results field. 
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Critical Student Information 
This tool should only be used by a System Administrator. Since this tool allows the 
user to change STISETSWeb information to match the same information in 
STIOffice, the person making the changes must verify the information in STIOffice 
before making any changes in STISETSWeb. WARNING: 

• Before changing student information, please make sure you are 
authorized to do so. 

• Make sure the data is correct in STIOffice. 

• Any changes made may get changed back on nightly update. 

• If you are unsure of the consequences and/or the use of this form, 
please contact STI Support.  

 

 

Change Case Manager 
To access this menu, click the plus sign to the left of Student Desktop. This option 
allows the user to change a student’s Case Manager. Only users with Administrative 
or Manager rights will have this option. 

• To change a Case Manager, begin by selecting a student. 

• Select Student Desktop | Change Case Manager. After selecting 
this menu option, the user may search by School, Last Name or First 
Name. Enter the desired criteria and click Search. 

• Once the desired employee name is highlighted, click Select. 
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Report Desktop 

A variety of reports are pre-loaded in the program. Adobe Acrobat Reader (a free 
download) is required for report generation. Only users with Manager or 
Administrative rights will have access to this menu. The difference in this menu and 
the one with the same name under Student Desktop is this Reports menu allows 
listing of all students in an entire school or district, whereas the Reports menu under 
Student Desktop only allows reporting for students on a particular teacher’s 
caseload.  

Reports 

To access this menu option click the plus sign by Reports Desktop from the menu 
tree at left; then select Reports. 

 

 
 

• Highlight the desired report on the left side of the screen. 

• If appropriate, select filter Options. 

• Click the down arrow to select the Output Format. 

o PDF brings up Acrobat Reader. 

o RTF brings up Microsoft Word. 

o XLS brings up Excel Spreadsheet. 

• Click Print to preview the report before printing.  

Sets Query 

This is the area designed to allow Administrators and Managers to build reports 
based on school-wide or district-wide listings. There is also a SETS Query 
(Caseload) that allows teachers to build the same custom reports for students on their 
caseloads. While the query is being built, a display of the report organization will 
appear at the bottom of the STISETS Query screen. This allows users to see how the 
report will be laid out. All reports generated from Sets Query are live reports, 
meaning you may click on any student’s name on the print preview screen and that 
student’s folder will display. The following information will guide users through 
creating a report. Our example report will list all students whose IEP specifies that 
they will take the Biology Assessment. The report will also include Last Name, First 
Name, Grade, Gender, Age and Race. 
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• School: The user may select from the drop-down list the particular 
school for which one is attempting to build a report. The user may also 
select the All Schools option to build a report. 

• Report Title: A report title may be entered in the appropriate text 
field. Our example title will be Mississippi Demo District Students 
Taking the Biology Assessment. 

• Xml, Htm, Txt: Choose the format in which the report will be 
generated by clicking the desired bullet box next to the Xml (used for 
trouble-shooting); Htm (Web page format); or Txt (text format) 
headings. Our example will be in Htm format. 

• Totals Only: Selecting this checkbox will yield a report generating 
totals only. 

• Active Only: Selecting this checkbox will yield a report including 
active students only. 

• Counts: Selecting this checkbox will display counts at the bottom of 
the screen based on the criteria selected. 

• Report Name: Use this text box to name the file and load or save it. 

• Run: Click this button when you are ready to run the report. 

• Load: Selecting this option allows the user to load a previously saved 
report. 

• Save: Selecting this option saves the report 

• New: Selecting this option clears all fields, preparing the screen for a 
new report. 

There are three headings which contain a myriad of text fields and drop-down boxes 
the user may apply to the report. 

• Student Fields: Enter data in the desired text fields to include 
information pertaining to the Student Fields in the report. Select the 
check box to include the information in the report. Our example query 
will include Last Name, First name, Grade, Gender, Age, and Race. 

• Folder Fields: Enter data in the desired text fields to include 
information pertaining to the Special Ed. Fields in the report. Select the 
checkbox to include the information in the report. Our sample report 
will include Case Manager Last Name and LRE Name. 
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• Form Fields: Enter data in the desired text fields to include 
information pertaining to the Form Fields in the report. Select the 
check box to include the information in the report. 

o Form: Click the down arrow to select a specific form. For our 
example, select IEP W- 4 Assessment Participation. 

o Field: Click the Ellipsis button to display the dialog box for 
selecting form criteria. For our example, select:  

 

 
 

 
 

• Run: Click this icon to run the report. The resulting report is shown 
below. Selecting Group Break allows grouping by grade, teacher, 
school, etc. 

 

2011 STISETSWeb MS         STI_0527111618 Getting Started  •  19 



 

 

Sets Query (Caseload) 

Unlike the previous Sets Query, this query is designed to build user-defined reports 
based ONLY on an employee’s caseload. An employee who has been assigned a 
security role of Teacher will use this report option after login. 

Since the functionality of Sets Query (Caseload.) is the same as Sets Query, the user 
may refer to the SETS Query section of this guide. 

Saving and Loading Queried Reports 
• After a report has been created using SETS Query, the report may be 

saved and loaded for use again. The following steps demonstrate how 
to save and load the report. 

• After running the report and closing the print preview screen, select 
Save. 
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• Select whether this report will be Public (meaning other employees 
may access this report) or Private (meaning only the person who 
created this report has access).  

 

 
 

• The report has been saved for future use. To load this saved query, 
click Load. After loading, this report is ready for previewing/printing. 
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User Desktop 

In the STISETSWeb User Desktop users will see their caseloads populating the 
Student Number, Last Name, First Name, Relationship, LRE, Special Education 
Status, Exceptionality, School, DOB, Age, Gender, Race and Grade fields. When an 
employee with teacher rights logs in to the program, the opening screen displays the 
User Desktop. A user’s caseload consists of students who are associated by way of 
case management, Special Education service and/or related service.  

When the user opens the program, the student demographic section of the screen will 
not be populated with data until a student is selected. After a student is selected, not 
only is that student’s information displayed at the top of the screen, but all Special 
Education processes that have been assigned to the student will be displayed. The 
screen has been prepared for working with the student’s forms, like a canvas ready 
for painting. 

 
 

• To select a student, double-click on the student‘s name. 

• Record of Access: This is a convenient feature that was added to 
track persons who access a student’s record. When anyone other than 
the Case Manager accesses a student’s record, it is automatically 
logged here. Clicking Insert allows the user to log other persons 
accessing the record.  
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• Processes: Clicking here allows the user to access any Processes 
assigned to the selected student. 

• Folder: Clicking here allows quick access to the selected student’s 
folder. 

Student Desktop 

Because the Student Desktop houses student records, Special Education teachers 
maintain those records here. This area of the software is essentially the teacher’s 
work place. Since all processes and the forms necessary for completion in each 
process are housed in this area, teachers can track Special Education students as they 
move from referral to eligibility to IEP development. 

Student Folder 

Housing the most current date information on students, this feature is accessed by 
clicking the plus sign to the left of Student Desktop; then selecting Student Folder. 
The student folder houses dates to be monitored for compliance. These fields will 
auto-populate from forms that are completed in the program.  

 

 

Basic tab 
• Status: Click the down arrow to select a status of Active, Contracted, 

Delete, Inactive, In-State, Not Eligible, Referred, Out-of State or 
Referred. 

o Active refers to all students currently receiving Special Education 
services. 

o Active/Referred refers to all students who are currently receiving 
Special Education Services but are being referred for another 
reason. 

o Contracted refers to students who services are contracted. 
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o Delete refers to students whose status is Delete. 

o Direct refers to all students whose services are provided directly in 
the Special Education classroom. 

o Inactive refers to all students who have left the school/LEA. 

o In-Direct refers to students whose services are provided in the 
general education classroom. 

o Not Assigned refers to students who have not been assigned a 
status category. 

o Not Eligible refers to all students who have been determined not 
eligible for Special Education services. 

o Referred refers to students who have been referred but not yet 
determined eligible for Special Education services. 

• Teacher of Record: The name of the teacher who will be responsible 
for maintaining this student’s Special Education record will be 
displayed in this field. 

• Exceptionalities: Click this link to enter the student’s 
exceptionality(s) 

• LRE: Click the down arrow to select the student’s Least Restrictive 
Environment. 

• Primary Language: Click the down arrow to select the student’s 
Primary Language. 

• Date Enrolled in District for Special Ed Services: Enter the 
most current date the student began receiving Special Ed services in 
your district. (Note: This date is NOT the student’s attendance 
enrollment date.) 

• Initial Placement Date: Enter the student’s Initial Placement Date. 

• Temporary Services: Enter the date on which the student was 
placed on Temporary Services if applicable. 

• Developmental History: Enter the Developmental History date. 

• School SAT: Enter the School SAT date. 

• DSAT: Enter the DSAT date. 

• Referral Date: Enter the student’s Date of Referral. 

• Parent Rights: Enter the most current date Parent Rights were 
explained/issued. 

• Request for Due Process: Enter the Request for Due Process Date 
if applicable. 

• Date of Eligibility: Enter the date eligibility was determined. 

• Re-Evaluation Date: After the Date of Eligibility is entered, the 
software automatically calculates the Re-Evaluation Date, three years 
minus one day. 

• IEP Begin Date: Enter the IEP Begin Date. 

• IEP Annual Review Date: Enter the IEP Annual Review Date. 

24  •  Getting Started      STI_0527111618 2011 STISETSWeb MS 



 

• Instructional Intervention Documentation: Enter the appropriate 
date. 

• Elementary/Secondary Teacher Narrative: Enter the appropriate 
date. 

• Parent Invitation to LSC Meeting: Enter the appropriate meeting 
date. 

• Notice of Initial Evaluation: Enter the appropriate date. 

• Psychological Report Date: Enter the appropriate date. 

• Psychological Report Date Expires: After the Psychological 
Report Date is entered, the software automatically calculates this date 
as three years minus one day. 

• Date: Enter the date on which the student enrolled in Special 
Education. 

This training guide does not list an explanation of appropriate information that 
should be entered in each field. These procedural questions should be directed to 
your Special Education Director.  

Basic Continued tab 
The following screen displays information from the Basic Continued tab in the 
folder. 

 
 

• Other Programs: Click to checkmark appropriate program. 

o Homeless 

o ESY=Extended School Year 

o ESL=English as a second language 

o Migrant 

o ESS=Extended School Services) 

• Resourced: 

o Resourced: Click to checkmark whether the student is Resourced. 
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o Self-Contained: Click to checkmark whether the student is Self-
Contained. 

o Student Representative: Enter the name of the Student 
Representative. 

o Student Representative Relation: Enter the relationship of the 
student representative. 

o Enter the remainder of date field information as appropriate. 

• User Defined Evaluation: 

o Type of Evaluation – Click the down arrow to select the Type of 
Evaluation. 

o Date – Enter the appropriate date of the evaluation. 

o Days to Expire – Enter the number of days the evaluation will 
expire. 

 Medicaid tab 
Select appropriate information on the Medicaid tab. 

 

Process Manager 

This feature allows the user to view and manage all processes assigned to a student. 
A process is defined as a group of forms that should be completed in a specified 
period of time. There are five buttons located on the left side of this screen. Working 
on all forms follows the same procedure. To access the Process Manager, click the 
plus sign beside Student Desktop, then click Process Manager. Generation of the 
IEP form will be used as an example. 

 

 
 

• Insert allows the user to attach a new process to a student. 

• Delete allows the user to delete a process from a student’s file if no 
forms have been completed in that process. 

• Deactivate allows the user to delete a process. You may deactivate a 
process with open or completed forms, but BE CAUTIOUS in using 
this option. THIS PROCESS IS IRREVERSIBLE! Once a record is 
deactivated, it writes that a process has been deactivated to the Record 
of Access. Only users with Manager rights have access to deactivate a 
process. 
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• Complete allows the user to finalize a process AFTER all required 
forms have been completed. After a process has been completed, the 
description of the Complete button changes to Re-Open. 

• Re-open allows a user to return to forms or processes that have been 
previously completed. 

• The Forms button will display all forms that are associated with the 
highlighted process. When this button is selected, the forms will appear 
on the left side of the screen.  

Generating an IEP 
• Selecting a Student: From the User Desktop, select a student by 

double-clicking on the student’s name. 

• Assigning a Process: Select Insert from the Process Manager 
menu.  

o The next screen provides a drop-down list displaying all processes. 

o Click the drop down arrow and select IEP. 

o Then click OK. 

• Locating the Forms in the IEP Process: After highlighting the 
IEP Process, click the Forms button at the lower left to display all 
forms contained in this process. 

 

 
 

• Working on Forms in the IEP Process: All forms required in the 
IEP Process will be displayed on the screen. A colored square icon 
displays to the left of each form. On the opening screen all forms have 
a white icon beside them until the form is opened. As forms are 
modified, the icons will change color. Resting the mouse on any icon 
displays a descriptive Tool/Tip. Icons are color-coded as follows: 

o Green: Designates that s form is Open. The form is in draft 
(Open) status; changes are allowed.  

o Red: Designates a Completed form. No changes are allowed 
except by creating an Amendment (Addendum). 

o White: Designates Not required for process completion. 

o Blue: Designates Open (Amendment). This is a previously 
completed form with an Amendment. 

• File Menu: Located in the upper left corner of forms, this menu is 
displayed after a process is opened. The following are options from the 
File menu: 
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o Save Changes – F10: Allows the user to save information on a 
form. You may also press F10 to save information on a form. If 
you try to exit a screen before saving information the following 
warning message will be displayed: 

 

 
 

If you have NOT saved the information, you should select Cancel before exiting the 
screen. Clicking OK allows exiting the screen without saving the information. 

o Reseed Data: Allows the user to update data on a form. After a 
saved form is re-opened, any additional information entered in the 
STIOffice program will automatically transfer to this form from 
the Special Education Folder. 

o Cancel Changes: Allows the user to cancel changes made to a 
form. 

o Complete Form: Allows the user to mark a form as Complete. 
No changes will be allowed after this option is selected except by 
Amendment. Required fields (those with red diamond icons) must 
be completed before this option is selected. Errors will prompt the 
user to enter required information before completing the form. 

o Print to PDF: Allows the user to open a form in a .PDF format 
for printing. 

o Print Process: Opens a screen allowing the user to print all or 
part of the forms in a process. 

• Edit Menu: The following list of options are available from the Edit 
menu: 
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o Check Spelling: Select this option for spell-checking, or press 
F7. 

o Show Form Indicators: Allows visually impaired users to see 
the status of each form in a process. 

o View Audit Trail: This feature allows access to the edited 
versions of a form by date. 

o Exit Form: Allows the user to exit a form. 

o Add Form: As forms are needed throughout a process, they may 
be added by selecting this option. A list of the forms in the process 
will be displayed. 

o Remove Form: Allows the user to delete the highlighted form if 
it is not a required form on the process. 

o Move Form: Allows the user to move a Completed form from an 
incorrect process to the correct process. This option should not be 
used to copy last year’s IEP to the current year. This is for use in a 
situation where a form has been completed for the wrong process. 

Note: To move a form from one process to another, the form must be in both 
processes. The user must open the incorrect form and select Edit | Move. A screen 
will display all of the processes this form may be moved to. Simply click on the 
correct process and the form should be moved. 

o Create Amendment: An amendment may be created to adjust 
data on a completed form. 

o Annotate Process: Allows the user to record commentary on 
the forms in a process. 

• IEP W-1 Summary of Performance in the Current Education 
Program: Click on the text, IEP W–1 Summary of Performance in the 
Current Educational Program in the light blue area on the left of the 
screen. Notice that the icon changes color from white to green. 

o Scroll down the screen to enter appropriate information on this 
form. 

o As information is entered on this form, select the File menu and 
then click Save Changes (or press the F10 key) to save the 
information.  

o After all required information has been completed on this form, 
select File and then click Complete Form. Notice the color of 
the icon to the left of the form changes to red, meaning this form is 
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locked and changes may only be made by creating an Amendment 
(Addendum). 

 
 

• IEP W-2 Supplementary Aids and Services, Personnel 
Supports in Regular Education: To access the next form in the 
IEP/Annual Review Process, click on the text in the light blue area of 
the screen. The link in blue text Click Here for Services allows entry of 
Supplementary Aids and Services. Entry of service information will be 
as follows:  
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o Click on the link Click Here for Services. 

o The next screen will be displayed. There are three tabs for Student 
Services: Related Services, Modifications/Accommodations, and 
Supports for Personnel. Each of these tabs follows the same 
procedure.  

 

 
 

o Scroll down the screen to enter appropriate information on this 
form. 

o As information is entered on this form, select the File menu and 
then click Save Changes (or press the F10 key) to save. 

o After all required information has been completed on this form, 
select File and then click Complete Form. Notice the color of 
the icon to the left of the form changes to red, meaning this form is 
locked and changes may only be made by creating an Amendment 
(Addendum). 

• IEP W-3a Measurable Annual Goal: Scroll down the screen below 
to complete appropriate information.  
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• IEP W–5 SCD Related Services and Special Factors: Time will 
not permit all IEP forms to be covered in this training session. We are 
selecting a cross-section of forms, to demonstrate the functionality of 
STISETSWeb Follow the same procedure to work on this form as in 
the previous forms. All forms are completed by scrolling down the list 
of forms in the light blue area of the screen. 

 
 

o Click on the link Click Here for Services. 

o The next screen will be displayed. There are three tabs for Student 
Services: Related Services, Modifications/Accommodations and 
Supports for Personnel. Completing information on each of these 
three tabs follows the same procedure.  

 
 

o Highlight the appropriate tab. For our example, we will highlight 
Related Services. 
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o Click Insert. 
 

 
 

o After entering appropriate information, click OK to save. Notice 
there are red and/or blue diamond icons by certain fields. Red 
means the field is required and has NOT been satisfied. Blue 
means the field requirement HAS been satisfied. 

o Insert: Click this button to insert a new service. 

o Change: To change an existing service, highlight the service and 
click Change. 

o Delete: To delete a service, highlight the service and click 
Delete. 

o Complete: To complete a service, highlight the service and click 
Complete. Note: No changes are allowed after a service is 
completed. 

o Tasks: Click here to enter tasks for the highlighted service. This 
area is a log of all the tasks performed for the selected student. 
After clicking the Tasks button, the following screen will be 
displayed. You will not be able to perform a task until your 
Administrator or Manager gives you rights. 

 

 
 

o Insert: Click here to enter a new task. 
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o Change: To change an existing task, highlight the task and click 
Change. 

o Delete: To delete an existing task, highlight the task and click 
Delete. Note: Deletion of completed tasks is not allowed. 

o Complete: After completing appropriate information click here to 
complete the task. No changes are allowed after a task has been 
completed. 

o After entering appropriate information, click OK to save. 

Note: Before entering tasks, it is recommended that an Administrator set up the 
credentialing information for the staff member from Utilities Desktop | 
Employees | Serv. Type. This will insure that the staff member is credentialed to 
perform the designated service. 

 
 

o Closing out the Tasks screen takes you back to IEP Section C. 

• Creating an Amendment to the IEP: The purpose of an 
Amendment (Addendum) is to make changes to a previously completed 
IEP. Creating an Amendment creates a draft copy of the original form 
for editing. The LED icon to the left of the form remains blue until the 
Amendment has been completed. The original version of the form may 
be viewed by selecting View Audit Trail from the Edit menu. You do 
not have to create a second instance of a form to modify your existing 
IEP. Follow these steps to create an Amendment: 

o Step 1: Open the completed form that needs editing. 

o Step 2: Select the Edit menu. 

o Step 3: Select Create Amendment. 
o Step 4: The form is ready for editing. Notice the icon changes 

color from red to blue. As long as the icon remains blue, changes 
are allowed. 

o Step 5: After making necessary changes, you may complete the 
amended form by selecting Complete Form from the File menu. 
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• Printing the IEP: There are two options for printing the IEP. Select 
one of the following from the File menu: 

o Print to PDF: This option allows the user to print a single 
selected (highlighted) form. 

o Print Process: Select this option to print ALL the forms in a 
process or multiple SELECTED forms in a process. Multiple forms 
may be selected by pressing the Ctrl key and then clicking on each 
desired form to highlight it. Click OK to continue. A preview of 
the form will be displayed on the screen. The process may then be 
printed by clicking the printer icon at the top of the screen. 
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• After all required forms in the IEP Process are complete, select 
Student Desktop | Process Manager. From this screen click the 
Complete button. If all required forms have been completed, a date 
will be displayed in the column labeled Close Date.  

Documents 

On the Documents screen, the user may Insert, Change, Delete or Download 
documents. These documents are saved in the database on the district server. Access 
this menu by clicking the plus sign by Student Desktop, then click Documents. 

 

 
 

• Insert: Click here to add a document that is not already pre-installed 
with STISETSWeb. 

• Change: Highlight the document; then click here to change an 
existing document. 

• Delete: Highlight the document; then click here to delete a document. 

• Download: Highlight the document; then click here to download a 
previously uploaded document. 

• Fill out the appropriate text fields in order to have your file added and 
uploaded. Then click OK. Notes mat be entered in the Notes field even 
without uploading a document. 
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• The uploaded file may be downloaded by selecting the Download 
button. At the next screen, click Open to view the attached file. 

 

 

STIOffice Info 

As stated in the overview to this guide, a variety of non-Special Education 
information is available in STISETSWeb. This up-to-the-minute data is drawn from 
STIDistrict and may be viewed by clicking the menu under STIOffice Information on 
the left side of the screen under the Student Desktop menu. The following types of 
data may be selected: 
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Bear in mind that all information drawn from STIOffice is read-only in 
STISETSWeb. Any changes to this data must be made from within the STIOffice 
application. An upload must occur in order for student information to be updated 
(schedule, guardian information, grades, etc.). 

Reports (Caseload) 

The report listings in this menu are designed specifically for teachers, allowing 
listings for students on each teacher’s caseload. From a teacher login, select 
Student Desktop | Reports (Caseload). To generate any of these reports, 
follow the same steps demonstrated in the section “Report Desktop” on page 17 of 
this guide. 
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Student Services 

To access this menu, select Student Desktop | Student Services. Notice that 
the Insert button is dimmed on this screen. Student Services are entered in the IEP 
forms W-2 and W-5 . This area of the software is intended for viewing services and 
entering Tasks (Service Logs).  
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